Pinball Tutorial (Basic)
Table of Contents

Getting Started ............................................................................................................. 3
Objective ...................................................................................................................... 3
Audience ...................................................................................................................... 4
Prerequisites ................................................................................................................ 4
Procedures .................................................................................................................... 4
Estimated Time to Complete ..................................................................................... 4

Setting Up Your Simulation Environment ................................................................. 5
Task Objective ............................................................................................................. 5
Estimated Time to Complete ..................................................................................... 5
Starting RecurDyn ....................................................................................................... 6
Adjusting the Icon and Marker Size ........................................................................ 6

Creating Geometry ..................................................................................................... 8
Task Objective ............................................................................................................. 8
Estimated Time to Complete ..................................................................................... 8
Creating the Guide Geometry .................................................................................... 9
Creating the Ball Geometry ......................................................................................... 12
Saving the Model ....................................................................................................... 13

Creating Forces ......................................................................................................... 14
Task Objective ............................................................................................................ 14
Estimated Time to Complete ..................................................................................... 14
Defining the Compressed Spring .............................................................................. 15
Defining the Contact Between the Balls .................................................................. 16
Defining Contact Between the Balls and Guides ..................................................... 17
Saving the Model ....................................................................................................... 19

Performing an Analysis and a Design Study ............................................................ 20
Task Objective ............................................................................................................ 20
Estimated Time to Complete ..................................................................................... 20
Performing Dynamic/Kinematic Analysis ................................................................ 21
Performing a Design Study ......................................................................................... 22
Animating the Results of a Trial ................................................................................ 26
Ideas for Further Exploration .................................................................................... 27
Getting Started

Objective

The modeling and simulation of contact between bodies is an important topic in multibody dynamics. RecurDyn has powerful capabilities to define and simulate all types of contacts, from simple to complex and with body geometry created in RecurDyn, as well as geometry that is imported from CAD software. Consideration of contacts is needed to model designs that have interesting responses to model changes.

In this tutorial, you’ll act as a company developing a novel pinball machine that includes a higher level of vertical motion. One aspect of the model is that the ball goes up and down a curved ramp as it is propelled from its starting point. The purpose of the tutorial is to select the spring that can store sufficient energy to propel the ball over the vertical obstacle.

This tutorial provides the first exposure to contact modeling. You will learn how to:

- Create wireframe geometry.
- Define 2D contacts between bodies.
- Define a parametric value.
- Run a design study.

You will:

- Simulate a small portion of a pinball game, where balls contact each other and guides that act as boundaries.
- Study the relationship between the driving force of the ball launcher and the response of the system.
**Audience**

This tutorial is intended for new users of RecurDyn. All new tasks are explained carefully.

**Prerequisites**

Users should first work through the 3D Crank-Slider Tutorial and the Engine with Propeller Tutorial, or the equivalent. We assume that you have a basic knowledge of physics.

**Procedures**

The tutorial is comprised of the following procedures. The estimated time to complete each procedure is shown in the table.

<table>
<thead>
<tr>
<th>Procedures</th>
<th>Time (minutes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation environment set up</td>
<td>5</td>
</tr>
<tr>
<td>Geometry creation</td>
<td>5</td>
</tr>
<tr>
<td>Contact definition</td>
<td>10</td>
</tr>
<tr>
<td>Spring and parametric value creation</td>
<td>10</td>
</tr>
<tr>
<td>Set up of design study</td>
<td>10</td>
</tr>
<tr>
<td>Analysis</td>
<td>5</td>
</tr>
<tr>
<td>Animation</td>
<td>5</td>
</tr>
<tr>
<td>Plotting</td>
<td>10</td>
</tr>
<tr>
<td><strong>Total:</strong></td>
<td><strong>60</strong></td>
</tr>
</tbody>
</table>

**Estimated Time to Complete**

This tutorial takes approximately 60 minutes to complete.
Setting Up Your Simulation Environment

Task Objective
Learn how to set up the simulation environment, including units, materials, gravity, and the working plane.

Estimated Time to Complete
5 minutes
Starting RecurDyn

To start RecurDyn and create a new model:

1. On your Desktop, click the RecurDyn tool.

RecurDyn starts and the New Model window appears.

2. Enter the name of the new model as Pinball.

3. Click OK.

Adjusting the Icon and Marker Size

You are now going to change the icon and marker size to 10 pixels so you can view the model better.

To change the icon and marker size:

1. Display the Icon/Marker window by doing one of the following:
   - In the toolbar, click the Icon Size tool.
   - From the View menu, click Icon Size.

   The Icon/Marker Size window appears.

2. Set Icon Size and Marker Size to 10.

3. Click OK.
To set the grid size to 10 in both the X and Z directions:

- In the second row of the upper toolbar, set the grid size to 10 in both text boxes by placing the cursor in each text box, clicking the left mouse button, typing 10, and then pressing the Enter key.
Creating Geometry

You will use wireframe geometry to define the ball guides in this pinball model. You will define all of the guides on the ground body, and define several balls at the model level as individual bodies.

Task Objective

Learn to create:

- Line and arc geometry that will guide the motion of the balls.
- Spherical geometry that represents the three balls in the model.

Estimated Time to Complete

5 minutes
Creating the Guide Geometry

To create the straight guide geometry:

1. To enter Body Editing mode for the ground body, in the Body toolkit, click the Ground tool.

   You know that RecurDyn is in Body Editing Mode for the Ground body because:
   
   - The title in the upper left corner of the working model window changes to Ground@Pinball.
   
   - The top item in the database window is Ground.

2. Change the working plane to the **XY Plane**.

3. In the Curve and Surface toolkit, click the Outline tool.

4. Click the following points or enter the coordinates into the Modeling Input toolbar:
   
   - **Point 1**: 0, 0, 0
   
   - **Point 2**: 110, 0, 0

5. Right-click and then click **Finish Operation** (the top item in the menu that appears) to finish the definition of the outline.

6. Click the Outline tool. Enter the following points:
   
   - **Point 1**: 140, 30, 0
   
   - **Point 2**: 140, 60, 0

7. Right-click and then click **Finish Operation**.

8. Click the Outline tool. Enter the following points:
   
   - **Point 1**: 230, 30, 0
   
   - **Point 2**: 450, 30, 0

9. Right-click and then click **Finish Operation**.

   The following appears in the working model window.
To create the arc guide geometry:

1. In the Curve and Surface toolkit, click the Arc tool.

2. Follow the directions given below, which are also summarized in the next figure.
   - **Center Point**: 110, 30, 0
   - **Radius Point**: 140, 30, 0
   - **Direction**: -Y (click at 140, 20, 0 or a grid point in that same direction such that the arrow points straight down.)
   - **Angle**: 90 (Carefully select the end of Outline 1 or enter 90 in the Modeling Input toolbar. Note that the angle displayed in the Working Model window will be shown in radians.)

3. Click the Arc tool. Enter the following:
   - **Center Point**: 170, 60, 0
   - **Radius Point**: 140, 60, 0
   - **Direction**: +Y (click at 140, 70, 0)
4. Click the **Arc** tool. Enter the following:
   - **Center Point**: 170, 60, 0
   - **Radius Point**: 120, 60, 0
   - **Direction**: +Y (click at 120, 70, 0)
   - **Angle**: 180 (you are forming a semi-circle)

5. Click the **Arc** tool. Enter the following:
   - **Center Point**: 230, 60, 0
   - **Radius Point**: 200, 60, 0
   - **Direction**: -Y (click at 200, 50, 0)
   - **Angle**: 90

The geometry appears as shown in the figure below:

![Geometry Diagram](image)

6. Exit the Body Editing mode for Ground by clicking the **Exit** tool (note that the Exit tool is available on the upper toolbars and in the pop-up window that appears when you right-click in the working model window).

7. Save your model. **(Tip:** From the **File** menu, click **Save.**)**
Creating the Ball Geometry

To create the ball geometry:

1. In the **Body** toolkit, click the **Ellipsoid** tool. Enter the following:
   - **Point**: 10, 10, 0
   - **Distance**: 10, 20, 0 (or enter 10 in the Modeling Input toolbar)

2. In the **Body** toolkit, click the **Ellipsoid** tool. Enter the following:
   - **Point**: 40, 10, 0
   - **Distance**: 40, 20, 0 (or enter 10 in the Modeling Input toolbar)

3. In the **Body** toolkit, click the **Ellipsoid** tool. Enter the following:
   - **Point**: 320, 40, 0
   - **Distance**: 320, 50, 0 (or enter 10 in the Modeling Input toolbar)

The three spheres that you just created are bodies that have the names of Body1, Body2, and Body3. You will change them to names that more helpful in identifying them.

To update the ball bodies:

1. Display the Properties window for Body1:
   - In the **General** tab, change **Name** to **Ball_1**.
   - Click **OK**.

2. Display the Properties window for Body2:
   - In the **General** tab, change **Name** to **Ball_2**.
   - Click **OK**.

3. Display the Properties window for Body3:
   - In the **General** tab, change **Name** to **Ball_3**.
   - Click **OK**.

You model appears as shown in the figure on the next page.
Saving the Model

- Take a moment to save your model before you continue with the next chapter. (Tip: From the File menu, click Save.)
Creating Forces

The behavior of this model is driven by forces. A compressed spring drives Ball_1 into Ball_2. The continuing motion of the balls results from gravity forces, contacts between balls, and contacts between the balls and the geometry.

**Task Objective**

Learn to create three types of force elements:

- Compressed spring that will act on Ball_1
- Sphere-to-sphere contacts between the balls
- Circle-to-curve contacts between the balls and the geometry

**Estimated Time to Complete**

10 minutes
Defining the Compressed Spring

You will create a spring force and adjust its properties to reflect that it is a compressed spring. As a result, Ball_1 will be pushed to the right when the simulation begins.

To create the spring:

1. In the Force toolkit, click the Spring tool.
2. Change the Input Mode from Point, Point to Body, Body, Point, Point.
3. Click in the background of the Working Model Window to select the Ground body to be the base body of the spring.
4. Click on the Ball_1 geometry to select Ball_1 to be the action body of the spring.
5. Click on the following locations in the Working Model Window:
   - Point1: -20, 10, 0
   - Point2: 10, 10, 0

To adjust the spring properties:

1. Display the Properties window for the spring, which will have the name of Spring1.
2. In the Spring tab, change:
   - Spring Coefficient to 20.
   - Damping Coefficient to 0.05
   - Free Length to 45.

   The length as defined is 30 mm. By changing the Free Length to 45, you are indicating that the spring is compressed by 15 mm. Given the spring Coefficient of 20, a load of 300 N will be applied to the ball at the beginning of the simulation. Once the spring length increases to 45 mm, the force becomes zero.
3. Click OK.
Defining the Contact Between the Balls

To create the contact between the balls:

1. In the Contact toolkit, click the Sphere To Sphere tool. Enter the following:
   - **Sphere**: click Ball_1
   - **Sphere**: click Ball_2

2. In the Contact toolkit, click the Sphere To Sphere tool. Enter the following:
   - **Sphere**: click Ball_2
   - **Sphere**: click Ball_3

To adjust the contact between the balls:

1. Display the Properties window for the first contact, which will have the name of SphereToSphere1.

2. In the Characteristics tab, change:
   - **Spring Coefficient** to 100.
   - **Damping Coefficient** to 0.2.
   - **Friction Coefficient** to 0.1.

3. Click OK.

4. Make the same adjustment to the contact properties of SphereToSphere2.
Defining Contact Between the Balls and Guides

The first ball (Ball_1) is constrained by the spring and will only contact the straight line as the left of the guide geometry. Therefore, the contact only needs to be defined for the one piece of geometry.

To create the contact between the first ball (Ball_1) and the guide geometry:

1. In the Contact toolkit, click the Circle To Curve tool. Enter the following:
   - Curve: click the line geometry under Ball 1
   - Sphere: click Ball_1

2. Display the Properties window for the contact, which will have the name of CircleToCurve1.

3. In the Properties window, do the following:
   - In the CircleToCurve tab, change its Normal Direction between Up and Down until the preview arrow is pointed up as shown in the figure below.
   - In the Characteristics tab, change:
     - Spring Coefficient to 100.
     - Damping Coefficient to 0.2.
     - Dynamic Friction Coefficient to 0.1.

4. Click OK to exit the contact Properties window.
The second ball (Ball_2) will contact all of the guide geometry. Therefore, you will use a different input mode for the contact to efficiently define all of the contacts.

**To create the contact between the second ball (Ball_2) and the guide geometry:**

1. In the Contact toolkit, click the Circle To Curve tool.
2. Change the Input Mode from Curve, Circle (Sphere) to Multicurve, Multicircle (sphere).
3. Enter the following:
   - **MultiCurve**: Click every piece of guide geometry
   - In the upper right corner of the working model window, click inside the Done1 box.
   - **MultiCircle (Sphere)**: click Ball_2
   - In the upper right corner of the working model window, click inside the Done2 box.
4. Display the Properties window for each of the seven new contacts, which will have the names CircleToCurve2 through CircleToCurve8.
5. For each, do the following:
   - In the CircleToCurve tab, change its Normal Direction between Up and Down until the preview arrow is pointed up as shown in the figure below (the size and location of the some of the arrows are adjusted for clarity).
   - Click the Base Curve Segment button. In the window that appears, change the number of Curve Segments to 20. Click OK to exit this window.
   - In the Characteristics tab, change:
     - Spring Coefficient to 100.
     - Damping Coefficient to 0.2.
     - Friction Coefficient to 0.03.
   - Click OK to exit the contact Properties window.
To create the contact between the third ball (Ball_3) and the Guide geometry:

1. In the Contact toolkit, click the Circle To Curve tool.
2. Change the Input Mode back to Curve, Circle (Sphere).
3. Enter the following:
   - Curve: click the line geometry under Ball_3
   - Sphere: click Ball_3
4. Display the Properties window for this contact and make the same adjustments as described for the first CircleToCurve contact.

Saving the Model

- Take a moment to save your model before you continue with the next chapter.
Performing an Analysis and a Design Study

Task Objective
In this chapter, you’ll run a simulation of the model you just created. You will rerun the simulation under a design study environment to decide how to select a spring that will provide the right energy to move the ball over the hump.

Estimated Time to Complete
5 minutes
Performing Dynamic/Kinematic Analysis

In this section, you will run a dynamic/kinematic analysis to view the effect of forces and motion on the model you just created.

To perform a dynamic/kinematic analysis:

1. In the toolbar, click the combo box next to the Simulate tool.

   The Dynamic/Kinematic Analysis window appears.

2. Define the end time of the simulation and the number of steps:
   - **End Time**: 1
   - **Step**: 500
   - **Plot Multiplier Step Factor**: 4

3. Click **Simulate**.

   RecurDyn calculates the motions and forces in the balls, spring and contacts. There will be 2000 plot outputs stored because the Number of Steps is 500 and the Plot Multiplier Step Factor is 4.

4. Animate the model by using the Play button on the Animation toolbar. Refer to the 3D Crank Slider tutorial for more details on playing an animation.

   Notice that Ball_1 (the ball that is attached to the spring) moves to the right and impacts Ball_2 just enough to push it to the right and have it climb a fraction of the height of the obstacle. You look in the spring catalog and you find that this spring is available in 1 mm increments from 40 mm through 70 mm. You want to try out different lengths of the spring but you don’t want to have run the various cases and keep track of the results manually.

   You want to do an automated design study, which is explained next.
Performing a Design Study

The steps to performing a design study for this model are:

1. Define the free length of the spring as a **Parametric Value** that can be adjusted during the design study.

2. Define a **Design Variable** from the Parametric Value, where you add information about the data boundaries. The range of the free length of the spring is from 45 to 60 mm.

3. Define a **Performance Index**. This is an outcome of interest for the design study. In this case, you will measure the maximum position of Ball_2 in the X direction. If the maximum position of Ball_2 is more than 170, then you know that it has passed the top of the vertical obstacle.

4. Set the **Number of Trials** for this design study, which is 16 (from 45 through 60 with steps of 1 mm).

5. **Run** the Design Study. Outputs will automatically be directed to different output files.

6. **Review** and **plot** the results from the design study.

7. **Animate** a particular trial.
To define a parametric value:

1. Display the Properties window for the spring (Spring1).

2. Next to the Free Length text box, click the Pv button.

3. When the Parametric Value List window appears, click the Add button.
   - Change the Name to Spring_Free_Length.
   - Set the Value to 45.
   - Click OK to exit the Parametric Value List window.

4. Click OK to exit the Spring1 Properties window. You will see that the name of the Parametric Value appears in the Free Length text box.

To define a design variable:

1. From the Analysis menu, select Design Study.
   The Design Study window appears

2. In the Design Variables section of the Design Study window, click the Add button.
   The Design Variable List window appears.

3. In the Design Variable List window, click the Create button.
   The Design Variable window appears.

4. Do the following in the window:
   - Change Name to DV_Spring_Lo.
- Click the \texttt{Pv} button and select the \textit{Spring Free Length of Parametric Value}.
- Click \texttt{OK} to exit the Parametric Value window.

5. In the Design Variable window:
   - Set \texttt{Value Range} to \textit{Absolute Min And Max Value}.
   - Set \texttt{Min Value} to \texttt{45}.
   - Set \texttt{Max Value} to \texttt{60}.
   - Click \texttt{OK} to exit the Design Variable window.

6. Click \texttt{OK} to exit the Design Variable List window.

To define a performance index:

1. Click the \texttt{Add} button in the Performance Indexes section of the Design Study window. The Performance Index List window appears.

2. Click the \texttt{Add} button in the Performance Index List window.
   - Change the \texttt{Name} to \textit{Ball_2_Travel}.
   - Set \texttt{Type} to \textit{Max Value}.
   - Click the \texttt{El} button.

   The Expression List window appears.

3. Click the \texttt{Create} button.

   The Expression window appears.

4. Do the following in the window:
   - Change \texttt{Name} to \textit{Exp_Ball2_PosX}.
   - In the Expression text box, enter \texttt{DX(1)}.
   - In the Argument List section of the Expression window, click \texttt{Add}.
   - Expand the \textit{Ball_2} body entry in the Database.
window and then expand the Markers entry that appears under Ball_2.

- Drag the name CM from the Markers entry under the Ball_2 body entry in the Database window to the blank text box in the Argument List section of the Expression window.

- Click OK to exit the Expression window.

5. Click OK to exit the Expression List window.

6. Click OK to exit the Performance Index List window.

To set the number of trials:

- In the Number of Levels text box in the Design Study window, type 16.

To run the design study:

- In the Design Study window, click the Simulate button.

16 runs occur in the output window. When the runs are complete, the Design Study window reappears.

To review and plot results:

1. Click the Result Sheet button.

A list of the 16 runs appears:

- The first column displays the value of the Free Length of the spring.

- The second column displays the maximum X value of the center of Ball_2.

By inspection, you can see that Trials 1-9 did not make it over the vertical obstacle because the Ball_2_Travel Performance Index is less than 170. Trials 10-16 have an output that is greater than 170, which means that the ball made it over the vertical obstacle and continued to the right.

2. To plot the Ball_2_Travel Performance Index, under the Performance Indexes heading, click the box in front of Ball_2_Travel, and then click Plot.
The following plot appears when you click the **Plot** button:

3. Click the **x** in the upper right corner and to close the plot and click **Close** in the Result Sheet window.

4. Click **OK** to close the Design Study window.

**Animating the Results of a Trial**

You'll first take a look at Trial 10, which is the first trial where Ball_2 makes it over the vertical obstacle.

To animate the results of a particular trial:

1. From the **File** menu, click **Import**.

2. Set **Files of type** to **RecurDyn Animation Data File (*.rad)**.


4. Animate the model using the **Play** button on the Animation toolbar.
Ideas for Further Exploration

You can gain a good understanding of the behavior of the pinball model by looking at the animations of several of the trials. Here are few more things to consider:

- The model used a low coefficient of friction (0.1). It represents the friction of a polished steel ball interacting with a smooth, dry surface. Low friction is a good assumption for the new pinball machine, but what about when the machine becomes old (dirty and some corrosion)?
  - How might the coefficient of friction change?
  - What could you do to study the effects of increased friction in this model?
  - Does increased friction require a stronger or weaker spring?

- How might installation of the pinball machine affect its performance? (Think of a floor that is not level.) How could you change the modeling approach to make it easier to consider non-level installations?

Thanks for participating in this tutorial!
Copyright © 2009 FunctionBay, Inc. All rights reserved
User and training documentation from FunctionBay, Inc. is subjected to the copyright laws of the Republic of Korea and other countries and is provided under a license agreement that restricts copying, disclosure, and use of such documentation. FunctionBay, Inc. hereby grants to the licensed user the right to make copies in printed form of this documentation if provided on software media, but only for internal/personal use and in accordance with the license agreement under which the applicable software is licensed. Any copy made shall include the FunctionBay, Inc. copyright notice and any other proprietary notice provided by FunctionBay, Inc. This documentation may not be disclosed, transferred, modified, or reduced to any form, including electronic media, or transmitted or made publicly available by any means without the prior written consent of FunctionBay, Inc. and no authorization is granted to make copies for such purpose.

Information described herein is furnished for general information only, is subjected to change without notice, and should not be construed as a warranty or commitment by FunctionBay, Inc. FunctionBay, Inc. assumes no responsibility or liability for any errors or inaccuracies that may appear in this document.

The software described in this document is provided under written license agreement, contains valuable trade secrets and proprietary information, and is protected by the copyright laws of the Republic of Korea and other countries. UNAUTHORIZED USE OF SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND CRIMINAL PROSECUTION.

Registered Trademarks of FunctionBay, Inc. or Subsidiary
RecurDyn is a registered trademark of FunctionBay, Inc.

RecurDyn/Professional, RecurDyn/Modeler, RecurDyn/Solver, RecurDyn/ProcessNet, RecurDyn/AutoDesign, RecurDyn/CoLink, RecurDyn/FFlex, RecurDyn/RFlex, RecurDyn/Linear, RecurDyn/CATIA Read & Write, RecurDyn/EHD, RecurDyn/ECFD_EHD, RecurDyn/Control, RecurDyn/Hydraulic, RecurDyn/MeshInterface, RecurDyn/Bearing, RecurDyn/Driver, RecurDyn/Spring, RecurDyn/Tire, RecurDyn/Belt, RecurDyn/Chain, RecurDyn/Crank, RecurDyn/Engine, RecurDyn/Gear, RecurDyn/HAT, RecurDyn/MTT2D, RecurDyn/MTT3D, RecurDyn/Piston, RecurDyn/Track_HM, RecurDyn/Track_LM, RecurDyn/TimingChain, RecurDyn/Valve are trademarks of FunctionBay, Inc.

Third-Party Trademarks
Windows and Windows NT are registered trademarks of Microsoft Corporation.

ProENGINEER and ProMECHANICA are registered trademarks of PTC Corp. Unigraphics and I-DEAS are registered trademark of UGS Corp. SolidWorks is a registered trademark of SolidWorks Corp. AutoCAD is a registered trademark of Autodesk, Inc.

CADAM and CATIA are registered trademark of Dassault Systems. FLEXlm is a registered trademark of GLOBE trotter Software, Inc. All other brand or product names are trademarks or registered trademarks of their respective holders.

Edition Note
These documents describe the training information of RecurDyn V7R3